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1 Introduction 

Welcome to Kramer Electronics! Since 1981, Kramer Electronics has been 
providing a world of unique, creative, and affordable solutions to the vast range 
of problems that confront the video, audio, presentation, and broadcasting 
professional on a daily basis. In recent years, we have redesigned and upgraded 
most of our line, making the best even better! Our 1,000-plus different models 
now appear in 11 groups1

Congratulations on purchasing your Kramer Room Controller (RC) device, 
which is ideal for controlling A/V equipment and media room items.  

 that are clearly defined by function. 

The configuration software is part of the package and includes this RC-SV 
Configuration Guide2

 
. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
                                                        
1 GROUP 1: Distribution Amplifiers; GROUP 2: Switchers and Matrix Switchers; GROUP 3: Control Systems; GROUP 4: 

Format/Standards Converters; GROUP 5: Range Extenders and Repeaters; GROUP 6: Specialty AV Products; GROUP 7: 

Scan Converters and Scalers; GROUP 8: Cables and Connectors; GROUP 9: Room Connectivity; GROUP 10: Accessories 

and Rack Adapters; GROUP 11: Sierra Products 

2 Download up-to-date Kramer user manuals and guides from the Internet at this URL: http://www.kramerelectronics.com 
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1.1 Quick Start 

To configure your Room Controller, follow these basic steps (see section  4): 

1. Download the software from our Web site 
at: http://www.kramerelectronics.com

2. Extract the ZIP file
3. Install the software application
4. Install the Kramer USB driver 

1. Check, according to your list of 
peripheral devices, that you have all the 
required drivers

2. Download the required drivers to a folder 
(for example, C:\Media-Room-
1\Peripheral Device Drivers)

1. In the Driver Manager window, select the 
required driver from the Vendor, Device 
and Revision areas 

2. Create a command via the Serial 
Command area or the IR Commands 
area

Click the “Port Manager...” Item in the 
Configuration menu and define as required
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2 Overview 
The RC-SV Configuration Software V2.1.2.69 is used to configure several 
types of room controllers1

Master Room controllers: 

. 

• SV-551 in a SummitView™ Essentials Kit for Europe or the US (the 
SV-551 is defined as the Master and the room controllers are the auxiliary 
devices) 

Room Controllers that operate as auxiliary devices to a master room controller 
or as standalone devices: 
• RC-6x2

 7
 Room Controller for Europe or the US (the room controller is 

connected as a standalone unit and is defined as the master), see section . 
• RC-2, RC-2C3 and the RC-2C3

• RC-52/RC-52N 
 combined with the PL-18 

• FC-29 for learning IR commands4

Section 

  

 3, section  4 and section  5 apply to all the room controllers listed in 
Table 1, unless noted otherwise 

Since each Room Controller includes different ports5, you will find that not all 
the available commands6

Table 1

 apply to your Room Controller. 

 defines the sections that apply to each Room Controller: 

Table 1: Room Controller Commands Available 
 The Commands [Section Number] 

Machine  IR OUT 
[ 5.2.1] 

RS-232 
[ 5.2.1] 

RS-485 
[ 5.2.1] 

LIGHT 
[ 5.2.2] 

RELAY 
[ 5.2.3] 

SWITCHER 
[ 5.2.4] 

POWER 
AMP [ 5.2.5] 

KEYPAD 
LCD [ 5.2.6] 

BUTTON 
COLOR [ 5.2.7] 

IGNORE 
BUTTON 
[ 5.2.8] 

SV-5517 Yes  Yes Yes  Yes Yes Yes Yes Yes Yes 

RC-6x2 Yes Yes   Yes   Yes Yes Yes 
RC-2 Yes          
RC-2C Yes Yes  Yes       
RC-2C + PL-18 Yes Yes   Yes      
RC-52 / RC-52N Yes Yes  Yes       

                                                        
1 For each machine, the installation process is described in the separate user manual. you can download the up-to-date 

Kramer user manuals and guides from the Internet at this URL: http://www.kramerelectronics.com 

2 Refers to the Kramer RC-62 and RC-63 families (European and US versions) 

3 The RC-2C (RC-2) firmware version must be at 1573 or higher 

4 The RC-SV Configuration software is used only for the purpose of IR learning and not for configuration 

5 For example, RC-2 includes only an RS-232 port, so the other commands are not available for this machine 

6 Section  4.5.2 describes the different command areas (some of which may not be available for your Room Controller) 

7 As Part of the Kramer SummitView™ Essentials Kit and Standard Kit European and US versions) 
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Before you operate the RC system: 
• Import the drivers of the peripheral devices  
• Configure your system1

• Write the configuration
 

1 
• Install the room controller system 

2.1 System Requirements for the Kramer RC-SV Configuration 
Software 

This section describes the system requirements for the Kramer RC 
Configuration software. 

2.1.1 System Requirements 

The system requirements include: 
• 400MHz processor 
• 128MB RAM 
• At least 300MB free hard disk space 
• Microsoft®  Internet Explorer 6.0 
• Network connection for configuring devices or USB 
• Microsoft.NET® Framework 2.0 Service Pack 1, automatically installed 

(see section  4.1) 

2.1.2 Operating Systems 

Microsoft® Windows XP® is the recommended operating system2

3 Initial Planning 

. 

Carefully plan your RC system layout to ensure a smooth and easy 
configuration and installation (refer to the separate User Manuals3

• Defining your requirements 
), by: 

• Listing the peripheral devices and room items that will be included in the 
system 

• Planning the location of each device 
• Planning the function of each device 

Make a detailed list of the functions and commands required of the system 
devices, as illustrated in the partial list in Figure 1: 

                                                        
1 The SV-551 for the SummitView™ system and the RC-6x for the standalone setup 

2 Windows NT does not support .NET 2.0. 

3 Download up-to-date Kramer user manuals and guides from the Internet at this URL: http://www.kramerelectronics.com 
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Figure 1: Media Room Components List 

Once this list is finalized and approved, you can carry on with the 
configuration and installation process.  

Note that the RC configuration and installation processes are independent of 
each other. You do not have to connect the RC device before starting the 

configuration  

4 The RC Configuration Software 

Install the software 

The Kramer RC-SV configuration software lets you set a sequence of 
commands (the macro) and assign them to any of the buttons on the RC 
device.  

The Kramer RC-SV configuration software lets you: 
• Create your own device drivers manually or via the IR learner feature 
• Write, modify or delete commands 
• Change the order of commands within the macro 
• Set delay times between commands in a macro 
• Set the button lighting and color 
• Change text on the LCD displays on the RC units 
• Save multiple sets of RC device configurations 

The RC buttons can be configured prior to installation 
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The following sections describe how to: 
• Install the software (see section  4.1) 
• Download the device drivers (see section  4.2) 
• Create Serial and IR commands (see section  4.3) 
• Map the ports (see section  4.4) 
• Use the Kramer RC Configuration main window (see section  4.5) 

4.1 Installing the Software 

Prior to using the Kramer RC-SV configuration software, make sure that the 
“.NET Framework” Revision 2.0 software is installed on your PC. If it is not, 
you need to install it:  
• If you have a fast Internet connection, this software is automatically 

installed during the installation of the Kramer RC-SV configuration 
software  

• If you do not have a fast Internet connection, insert the CD-ROM into the 
CD-ROM drive, double click the dotnetfx.exe1 file and follow the 
on-screen instructions2

Before getting started with your Kramer RC-SV configuration, you must 
download the software and then install it. You can download it

 

3

1. Go to our Web site at 

 from the 
Internet. To do so: 

http://www.kramerelectronics.com and download the 
file: “Kramer RC-SV Config.zip” from the DOWNLOADS section. 

2. Extract the file “Kramer RC-SV Config.zip” package, which includes the  
Kramer RC configuration 2 application setup and the Kramer device drivers4

3. Install the Kramer RC-SV Configuration application. 
When running Setup, you are prompted to set the working directory (see 

, 
to a folder (for example, C:\Program Files\Kramer RC Configuration). 

Figure 2): 

                                                        
1 File names are liable to change 

2 Installation may take about 15 minutes 

3 File names are liable to change from time to time 

4 Mostly for matrix switchers and switchers 

http://www.kramerelectronics.com/�


The RC Configuration Software 

 

7 

 
Figure 2: Driver Database Notice 

4. Click OK. 
The following window appears (see Figure 3): 

 
Figure 3: Setting a Working Directory 

5. Select or create a new working directory1 Figure 4 (see ). 

                                                        
1 The working directory will keep the information that is essential for operating the software. This information will remain 

unchanged while upgrading the software 
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Figure 4: Change Working Directory Window 

6. Continue to run the setup according to the installation instructions. 

4.2 Downloading and Installing the Drivers 

Download and Install the Drivers 

The RC system peripheral devices have device drivers that let them 
communicate with computers. The device driver needs to be installed so that 
the computer can recognize it and control it. The Kramer RC-SV 
Configuration software uses driver commands to control these peripheral 
devices. 

4.2.1 Download the Drivers 

Check—according to your list of peripheral devices (see the example in 
Figure 1) —that you have all the required drivers: 
• Kramer machines have drivers that are provided within the package 
• Other peripheral device drivers that are included in the package 

Download the required drivers to a folder (for example, C:\Media-Room-
1\Peripheral Device Drivers).  

4.2.2 Install the Drivers 

The peripheral device drivers are installed via the Driver Manager window, 
defined in Figure 8 and Table 2: 
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To access the Driver Manager window: 
1. Open the Kramer RC-SV Configuration program. 
2. The following window appears: 

  
 Install the Kramer USB driver from the installation disc or from our Web site 

at http://www.kramerelectronics.com. 
3. From the File menu, click Driver Manager. 

The Driver Manager window appears (see Figure 5). 

When open, the Driver Manager window lets you: 
• Import one or more drivers (Import Drivers…, see Figure 6), or export an 

existing driver (Export Driver…, see Figure 7) 
• Add a new device driver 
• Rename or delete devices, revisions and commands, as defined in Table 2 
• Set the driver revision date 
• Write new commands  
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Figure 5: The Driver Manager Window Prior to Installing the Drivers 

 
Figure 6: Importing a Kramer Driver File 
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Figure 7: Exporting a Kramer Driver File 

Figure 8 and Table 2 define the Driver Manager window: 
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Figure 8: The Driver Manager Window 
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Table 2: Driver Manager Window Features 
# Feature Function 
1 Vendors Area Lists the downloaded vendors  

New: press to enter a new vendor name manually 
Rename: press to rename the vendor name 
Delete: erases the selected vendor 

2 Devices Area Lists the names of devices of a selected vendor (in the Vendors area) 
New: press to enter a new device name manually 
Rename: press to rename the device name 
Delete: press to erase the selected device 

3 Revisions Area Lists the revision of a selected device 
New: press to enter a new revision manually 
Rename: press to rename the revision number 
Delete: press to erase the selected revision 

4 Driver Area Displays the selected Vendor, Device Model and Revision. Lets you set 
the Revision Date 

5 Command Area Displays the command type (see Figure 10 and Figure 13) 
6 IR Commands Area Lists the IR command names for a specific device 

New: press to enter a new command name manually 
Rename: press to rename the Command editing tab 
Delete: erases the selected command  

7 Serial Commands Area Lists the serial command names for a specific device 
New: press to enter a new command name manually 
Rename: press to rename the Command editing tab 
Delete: press to erase the selected command 

8 Queries N/A in this version 
9 Serial Settings Area Select the serial settings for the device: the Baud Rate, the Data Bits, the 

Parity and the Stop Bits 
10 Device Default Power 

Commands 
N/A in this version 

11 Monitor Answers N/A in this version 
12 Groups N/A in this version 
13 OK Button Apply changes and close window 
14 Cancel Button Close window without applying changes 
15 Apply Button Apply changes, but do not close window 
16 Drivers Area Import Drivers…: press to import one or more driver files 

Export Driver…: press to export a driver file 
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4.3 Creating a Driver Command 

Create serial and IR commands 

Driver commands are written via the connectors specific to each of the 
machines, as defined in Table 3: 

Table 3: Connectors Available for Driver Commands 
Machine Name Connectors Available Connection Method 

SV-551 ETH, USB Ethernet, USB 
RC-6x USB USB 
RC-2 RS-232 Serial 

RC-2C RS-232 Serial 
FC-29 USB USB 
RC-52 USB USB 

You can write two types of commands to a connected device (for example, a 
DVD, or a Kramer machine): 
• Serial commands (see section  4.3.1) 
• IR commands (see section  4.3.2) 

4.3.1 Creating a Serial Command 

To write the serial commands for the selected device, click the New button in 
the Serial Commands area. The New Serial Command window appears. Type 
the new command name: 

 
Figure 9: New Serial Command Window 

A Serial Command type area appears, as illustrated in Figure 10. 
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Figure 10: Writing the Serial Commands 

The serial commands created can be sent via RS-232 and RS-485 ports. 

4.3.2 Creating an IR Command 

To create IR commands for a selected device, connect the FC-29 or RC 
device1 directly2 to your PC via the USB connector and use the remote control 
transmitter3

When creating IR commands, you have to connect the device directly to the 
PC via the USB connector. When a RC-6x (in the slave configuration) is 
connected, although it is directly connected, it should remain in the auxiliary 
device state because if it is defined as master, it will not function when 
reconnected to the SV-551. 

 to learn its IR commands.  

To keep the RC-6x in the auxiliary device configuration: 
1. Connect the RC-6x directly to the USB connector. The following window 

appears: 

 
2. Click NO to keep the device in the auxiliary device configuration. 

If you have a problem connecting to the USB port, make sure that you have 
installed the Kramer USB driver (see section  4.2.2). 

                                                        
1 That has IR learning capability, as defined in Table 3 

2 Whether it is defined as an auxiliary device or a standalone Master 

3 Of the machine from which you want to learn the IR commands. For example, use the DVD control transmitter to write the 

DVD commands to the driver manager 
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To write a new IR command to the RC device: 
1. Click the New button in the IR commands area to type the new command name. 

The following window appears: 

 
Figure 11: New IR Command Window 

2. In the Command area, click the Connect to IR Capture Device button (see 
Figure 13), select the port and click OK: 

 
Figure 12: Connect to IR Capture Device Window 

3. Click the Read IR button to read the command.  
The command area displays the following message: “Ready for reading IR 
command. Please send IR command to the device”. 

4. Press the appropriate button on the remote control transmitter.  
The command area displays the following message: “IR command reading”. 
The IR command appears, as illustrated in Figure 13: 
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Figure 13: IR Command Area Window 

You can test the IR command by connecting the RC unit IR terminal block 
connectors to the device via the IR emitter, and then clicking the IR-Out 
Testing button. 

Figure 14 shows how to connect the IR emitter1. The white striped side 
connects to IR OUT, the black side connects to the Ground, and the LED 
Emitter Shell is affixed to the IR sensor window with the adhesive layer. 

 
Figure 14: IR Emitter Wiring 

NOTE: The dual IR emitter emits a weaker IR signal that may not be detected 
by some devices 

 

 

 

 

 

 

 

                                                        
1 Using the Kramer 3.5mm to IR Emitter Control Cable (C-A35/IRE-10) 
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4.4 Port Mapping 

Write a description and assign the Default Driver for each port 

The Port Manager window defines the ports on the Room Controller (see 
section  2) and lets you write a description and assign a default driver for each 
port. For example, if a DVD is connected to the SV-551 via the IR_2 port, you 
can change the description next to that port to “Sony DVD” and assign the 
Sony DVD driver to this port. 

In this way, the Sony driver will be associated with the Sony DVD port1

Figure 15
 when 

creating a command sequence as illustrated in , making it easier to 
select the commands (also see section  4.5.3). The same applies to all the ports 
in the Port Manager window. 

  
Figure 15: The Sony DVD Player in the RC Command Area 

For the RS-232 and RS-485 ports on the unit, the Port Manager window also 
lets you set the baud rate, data bits, parity and stop bits. These definitions will 
override the definitions written in the driver manager. 

To open the Port Manager window, click the “Port Manager…” item in the 
Configuration menu (see section  6.3). Figure 16 shows the Port Manager 
window for the Kramer SV-551 SummitView™ Processor / Switcher2

                                                        
1 Although you can assign it with a different Vendor or Device 

. 

2 Figure 60 shows the Port Manager window for the RC-6x standalone setup 
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Figure 16: The Port Manager Window 

Table 4: The Port Manager Window Features 

The Item Description 
Port Lists the ports available for the selected machine 
Description Type a description of the port 
Settings For serial ports, press the white area to open the serial Settings window and define the baud 

rate and parity 
For Ethernet ports, press the white area to open the Ethernet Settings window and define the 
IP address and TCP port 

Main Display N/A in this version 
Default Driver Press the white area to open the Drivers Tree window and select the default driver for this port  

 
Press to clear the Default Driver data 

Reset Press to reset to default definitions 
OK Click to approve and exit window 
Cancel Click to exit window 
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4.5 The Kramer RC-SV Configuration Main Window 

After importing the drivers and defining the ports, use the Kramer RC 
Configuration main window to assign a sequence of commands (the macro) 
for each RC button. Figure 17 illustrates the Kramer RC-SV Configuration 
main window1 Table 5, and  defines it:  

 
Figure 17: The Kramer RC Configuration Main Window 

Table 5: Kramer RC Configuration Window Features 
# Feature Function 
1 Menu Bar Menus are described in section  5 
Device Area 

2 Connection Box Displays the connection properties with the device (IP address or 
com port)2 

3 Name Box Displays the name of the specific device2

4 
  

Master Box Displays the Master device to which the auxiliary device keypad is 
connected. Change the master device type and the auxiliary device 
Keypad via the File menu (see section  6.1) 

5 Keypad Box Select the device type3

6 
 

Keypad Tab Shows the layout of the RC buttons according to the device type 

                                                        
1 The Window appearance is slightly different for each machine (for example, the keypad is specific to the machine selected) 

2 The name and IP number are initially set by the Properties dialog box (see section  7.2) 

3 The device type can be selected only if there is no device connected to the computer. If a device is connected, the device 

type is selected automatically 
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# Feature Function 
selected, with the labels on the button. Click to Select a button to 
configure, modify, read, or delete its macro.  
When the button is: 
• Blue rimmed, it is assigned a command sequence 
• Green, it is selected 
• Gray, it is not assigned a macro 

 Event Macros Tab A series of commands to be executed upon a scheduling time (see 
Figure 19) 

7 Button Area1 Label Text Box  Select a button and type the required button label 
8 Behavior Drop-

down Box 
Assign the button response to press and release actions 
Button Definition  Behavior 
Activate on Release 
(default) 

The macro is executed upon releasing 
the button 

Activate while Pressed The macro is activated and repeated 
for as long as the button is pressed 

Toggle 1-2-3-4 Cycling macro behavior: 
The button can be assigned with up to 
4 different macros. Each time it is 
pressed, the next macro in the set will 
be activated in a cyclic fashion.2

# 
 

Feature Function 
9 Write Configuration Button3 Press to write the configuration of all the buttons to the device  
10 Read Configuration Button Press to read the configuration of all the buttons from the PC to the 

device 
11 Set Device Clock Check Box Check to set the device clock to that of the PC 

Button Macro Area 
12 Button Macro Display Box Displays the macro RC commands’ Description, Delay and Port in 

sequence. Select an RC command to duplicate, delete, or change 
its position in the sequence 

 New Command Button Click to add a new command to the Button Macro display box4

 4.5.2
 (see 

section ) 
 Duplicate Command Button Duplicate a command in the Button Macro display box 
 Delete Command Button Delete a command from the Button Macro display box 
 

 Button 
Move up the selected command  

  Button Move down the selected command  

13 RC command Area (see section 
 4.5.3) 

Appears different for different ports and includes the following 
features of the command selected in the Button Macro display box: 

 Description Text Box Optional descriptive text for the command 
 Port Drop-down Box Displays the port associated with the RC command: Select a port 

when modifying or writing a new RC command  
14 Delay after command Text Box5 Set a delay time following the command 6

                                                        
1 The Button area appears only after selecting a button in the Front Panel tab 

 

2 The number of toggle states can be determined (from 1 to 4). The selected number of toggle states appears above the Button 

Macro area (see Figure 18) 

3 This button is enabled only when a device is connected to the PC. Otherwise it is disabled 

4 The button macro display box displays <No Description> under Description and None under Port 

5 Shows after checking this option in the configuration menu 

6 In seconds or milliseconds, via check box 
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Figure 18 shows the Toggle button behavior: 

 

 

Figure 18: Using the Toggle 1-2-3-4 Behavior 

4.5.1 The Tab Area 

The tab area includes different tabs, depending on the machine type: 
• The keypad tab, illustrated in Figure 17 and defined in Table 5, lets you 

assign macros to the buttons (see section  5) 
• The Event Macros tab, illustrated in Figure 19, lets you add commands to 

several built in macro events1

 4.5.2
, and create up to five additional custom 

macros that are activated upon the scheduling time (see section ) 

  
Figure 19: Event Macros Tab 

 
 
 
 
 
 

                                                        
1 Startup, Inactivity Timeout, All On and All Off that are activated automatically, and also several custom event macros 
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4.5.2 Scheduling 

You can schedule the custom macros to be activated at a predefined time, as 
illustrated in Figure 20: 

 
Figure 20: The Scheduling Window 

4.5.3 The RC Command Area 

The RC Command area appears different for the various types of ports. 

4.5.3.1 The IR, RS-232 and RS-485 Ports RC Command Area 

Figure 21 and Table 6 define the IR, RS-232 and RS-485 Port Command area: 

 
Figure 21: IR, RS-232 and RS-485 Port RC Command Area 
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Table 6: IR, RS-232 and RS-485 Port Command Area Features 
Drop-down Box Description 

Vendor Drop-down Box Displays the current vendor. Select the vendor when writing a 
new RC command or modifying a selected command 

Device Drop-down Box Displays the device driver name. Select the device driver when 
modifying or writing a new RC command 

Revision Drop-down Box Displays the device driver revision. Select a revision when 
modifying or writing a new RC command 

Driver command Drop-down Box Displays the current driver command. Select a driver command 
when writing a new command or modifying a selected command 

4.5.3.2 The LIGHT RC Command Area 

The LIGHT Command lets you set the button lighting behavior (see Figure 22). 

 
Figure 22: LIGHT RC Command Area 

4.5.3.3 The Relay Port RC Command Area 

The relay RC Command Area includes the Relay command drop-down box 
(Close, Open): 

 
Figure 23: Relay Port RC Command Area 
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4.5.3.4 The Switcher Port RC Command Area 

The switcher port command area includes the SV-551 Switcher command 
drop-down box:  

 
Figure 24: Switcher Port RC Command Area 

4.5.3.5 The Keypad LCD Port RC Command Area 

The keypad LCD port RC Command area includes the LCD command drop-
down box, which lets you type any text (up to 8 characters) to the LCD 
display on the control device:  

 
Figure 25: Switcher Port RC Command Area 

4.5.3.6 The Button Color Port RC Command Area 

The button color port RC Command area lets you select the button color and 
state (On Off, Fast Blink and Slow Blink) for each button:  

 
Figure 26: Button Color Port RC Command Area 
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Figure 27: Color Selection Window 

4.5.3.7 The Ignore Button Port RC Command Area 

The Ignore/ Unignore command lets you control whether a press of a button 
will issue the associated sequence of commands for that button. For example, 
inserting "IGNORE button 4" into another button's command macro, will 
actually disable button 4 until the "UNIGNORE button 4" command will be 
issued from another command macro. 

 
Figure 28: Ignore Button Port RC Command Area 
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5 Creating a Macro 

Configure the RC buttons 

A macro includes a sequence of commands assigned to: 
• A selected button on the RC device 
• An Event Macro 

To create a sequence of commands: 
1. Press a button in the Keypad1 tab to select the button to which you want to 

write the macro. The button turns green: 

 
Figure 29: Selecting a Button to Write a Macro 

2. Click the New button in the Button Macro area: 

                                                        
1 Or the Event Macros tab, or the RC-4 tab 



KRAMER:  SIMPLE CREATIVE TECHNOLOGY 

Creating a Macro 

 28 

 
Figure 30: Creating a New Command 

3. Select a port1

4. Select a command from the Driver command area and write its description. 
Click the up or down arrow to save the command to the macro: 

 from the drop-down box (for example, the RS-232 terminal 
block). The default driver appears. 

 
Figure 31: Selecting the Port 

                                                        
1 This is an example. The RC command area appears different for different ports, as described in section  5.2 
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5. Repeat this process to add new commands. Click Duplicate to duplicate the 
command and delete a command by clicking the Delete button. 

6. If required, set a delay time after the command. 

5.1 Labeling the Buttons 

For your convenience, you can label the buttons in the Keypad tab area, as 
illustrated in the example in Figure 32. 

 
Figure 32: Labeling the RC Buttons 

To label a button: 
1. Open the Kramer RC Configuration main window. 
2. Select a button. 
3. Type the button text in the Label area: 

 
Figure 33: Typing the Label 

5.2 Creating a Driver Command 

The driver commands for each port are slightly different. The following 
sections describe how to write a new command for the different ports. 

Each machine has a different set of commands, as defined in Table 1 
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5.2.1 An RS-232 Command – Switch Input to Output 

To add a driver command to a button (for example, to switch the DVD player 
to the projector), do the following: 
1. Open the Port drop-down box and select the RS-232 Terminal Block (or IR 

OUT or RS-485) port1 from the list2

2. In the RC command area, write the command description (for example, 
SWITCH). 

. 
If a driver was assigned in the port mapping stage, the default driver associated 
with this port appears. 

3. Select the Driver command (for example, “COMP!”) from the drop-down 
box2.  

Figure 34 illustrates the RS-232 RC Command area as it appears after writing 
the driver command: 

 
Figure 34: Switch to COMP1 Command 

5.2.2 A LIGHT Command – Select the Button behavior 

To change the color of a button, do the following: 
1. Select the LIGHT Port. 
2. In the RC command area, write the command description (for example, Button 

blinks). 
3. In the Button lighting area, click the button for which you are writing this 

command until it is in the Blink state. 

Figure 35 illustrates the RC Command area as it appears after writing the 
command and the button color selection list: 

                                                        
1 Once the port is selected, the default driver details appear 

2 If the required data does not exist, you can install it via the Manager Driver window (see section  4.1) 
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Figure 35: LIGHT Command 

5.2.3 A Relay Command – Turn Lights ON  

To write a relay command on an RC button (for example, turn the lights on), 
do the following: 
1. Select the Relay Port (for example, RELAY_1). 
2. In the RC command area, write the command description (for example, Lights 

ON). 
3. Select the relay command (for example, Close). 

Figure 36 illustrates the RC Command area as it appears after writing the 
command: 

 
Figure 36: Lights ON RC Command 
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5.2.4 A Switcher Command 

Use the Switcher command to select an input connected to the Kramer 
SV-551 (Video 1, Video 2, PC 1, PC2 and PC 3). The switcher command 
applies to the master-slave configuration only. 

To write a switcher command on an RC button, do the following: 
1. Select the SWITCHER Port. 
2. In the RC command area, write the command description (for example, 

Select). 
3. Select the switcher command (for example, Video 1). 

Figure 37 illustrates the RC Command area as it appears after writing the 
command: 

 
Figure 37: Switcher RC Command 

5.2.5 A Power Amplifier Command 

To write a power amplifier command1

1. Select the POWER_AMP Port. 
 on an RC button, do the following: 

2. In the RC command area, write the command description (for example, High 
Volume). 

3. Select the power amplifier command (for example, Volume set). 
4. Move the sliding switch to the desired volume (for example, 12dB). 

Figure 37 illustrates the RC Command area as it appears after writing the 
command: 

                                                        
1 For the Master-Slave configuration only 
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Figure 38: High Volume RC Command 

5.2.6 An LCD Keypad Command 

The LCD Keypad command lets you type-in the desired text to the LCD 
displays (LCD 1 and LCD 2). 

To write an LCD keypad command on an RC button, do the following: 
1. Select the KEYPAD_LCD Port (1 or 2). 
2. In the RC command area, write the command description (for example, 

Switcher). 
3. Type-in the desired text. 

Figure 37 illustrates the RC Command area as it appears after writing the 
command: 

 
Figure 39: Keypad LCD RC Command 
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5.2.7 Setting the Button State and Color 

To write a Button Color command on an RC button, do the following: 
1. Select the BUTTON_COLOR Port. 
2. In the RC command area, write the command description (for example, 

Change Color). 
3. Select the Button ID (from 1 to 6) to which this command refers1

4. Set the state of the button (On, Off, Fast Blink, Slow Blink), for example, On. 
. 

5. Set the Button Color (see Figure 41). 

Figure 40 illustrates the RC Command area as it appears after writing the 
command: 

 
Figure 40: Change Color RC Command 

                                                        
1 For example, the command is written to button 1 but refers to an action taken for button 4 
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Figure 41: Select Button Color 

5.2.8 The Ignore Button Command 

To write a Button Ignore command (see Figure 42) on an RC button (for 
example, button 1), do the following: 
1. Select the IGNORE BUTTON Port. 
2. In the RC command area, write the command description (for example, Ignore 

Button 4). 
3. Select the Button ID (from 1 to 6) to which this command refers1

4. Set the state of the button (Ignore, Unignore), for example, Ignore. 

, for example 
button 4. 

Figure 42 illustrates the RC Command area as it appears after writing the 
command to button 1: 

                                                        
1 For example, the command is written to button 1 but refers to an action taken for button 4 
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Figure 42: Ignore RC Command 
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6 The Kramer RC Configuration Menus 

This section describes the Kramer RC Configuration menus. 

6.1 The File Menu 

Figure 43 illustrates the File menu and Table 7 defines it: 

 
Figure 43: The File Menu 

Table 7: File Menu Features 

Menu Command Function 
New Project Click to create a new 

configuration setup, see 
Figure 441

Open Project 
. 

Open an existing 
configuration setup 

Save Project Click to save the current 
configuration (does not 
save the relevant driver 
commands). 

Save as Project Save the configuration 
under a different name 

Load Configuration… Click to load a saved 
configuration. 

Driver Manager … Click to open the Driver 
Manager window (see 
section  4.2.2). 

Change Working 
Directory… 

Click to set the new 
working directory2

Exit 
. 

Click to exit the program. 

 
Figure 44: The Configuration Setup Window 

 
 
 

                                                        
1 This will discard the active configuration 

2 The working directory can be changed at any time 
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6.2 The Edit Menu 

Figure 45 illustrates the Edit menu and Table 8 defines it: 

 
Figure 45: The Edit Menu 

Table 8: Edit Menu Features 

Menu Command Function 
Copy Macro Click to copy a button macro 

command sequence. 
Paste Macro Click to paste a button macro 

command sequence. 
Clear Macro Click to clear the Macro-

commands sequence box. 
Clear Button Labels Click to clear all the button 

labels. 

  

6.3 The Configuration Menu 

Figure 46 illustrates the Configuration menu and Table 9 defines it: 

 
Figure 46: The Configuration Menu 

Table 9: Configuration Menu 
Features 

Menu Command Function 
Port Manager Lists the ports names, 

description, settings and 
drivers (see section  4.4). 

Show Delay Check to show in RC 
main configuration 
window.  

Show Button 
Lighting 

Check to show in RC 
main configuration 
window. 

Volume Control 
Properties 

Set the volume control 
type1

 

 

Web Settings N/A in this version 

 
 
 
 
 
 

                                                        
1 Applies only to the SV-551 



The Kramer RC Configuration Menus 

 

39 

6.4 The Device Menu 

Figure 47 illustrates the Device menu and Table 10 defines it: 

 
Figure 47: The Device Menu 

Table 10: Device Menu Features 

Menu Command Function 
Connect… Click to connect to a device via 

an IP number or serial port. 
Disconnect Click to disconnect the device 
Properties1 Click to show the device 

properties dialog box. 
 

Write Configuration1 Writes the configuration to the 
device. 

Load Firmware Load file for firmware upgrade. 
Set As Slave Enabled when the RC is 

connected as a standalone unit. 
Lets you set the device as a 
slave. The RC controller will 
automatically disconnect 

Scheduling Set the Macro Events schedule  
Clear Device 
Configuration 

Removes the configuration from 
the device 

  

6.4.1 The Connect Command 

To connect a device, do the following: 
1. Open the Device menu and click Connect. 

The Connect window appears (see Figure 48). 
2. Select the Connection method and type the IP number of the desired device (or 

port). 

 

Table 11: Connect Dialog Box 

Feature Function 
Connection 
Method Area 
 

Check Ethernet to select the 
connection to the device via the 
Ethernet, USB or Serial port. 

Ethernet Area IP: Type the IP number of the 
device you want to connect to. 
Port: shows the port number. 
Factory Default Address Button: 
Press to reset the IP number to its 
default value. 

USB Area Port: select the communication USB 
port. 
Refresh Ports: click to check if there 
are ports ready to connect on the 
Kramer device. 

                                                        
1 Active only when a device is connected 
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Figure 48: Device Selection Dialog Box Serial Select Port: select the 
communication port 

6.4.2 The Device Properties Dialog Box 

To connect a device, open the Device menu and click Properties. The Device 
Properties window Appears (see Figure 49). Figure 57 shows the Device 
Properties window in the standalone setup. 

 
Figure 49: Device Properties Window 

Table 12: Connect Dialog Box 

Feature Function 

Name, IP, Gateway, 
Mask 

If required, change information. 

Model, Serial number, 
Port, Firmware, K-Net-
ID, MAC,  

Displays information. 

DHCP44F

1 Enabled Check box to enable operation in 
the DHCP mode.  
When in the DHCP mode, you 
can only change the name of the 
device. 
This process may take several 
minutes and will cause an 
automatic restart on the device. 

  
  
  
  

6.5 The Help Menu 

Figure 50 illustrates the Help menu and Table 13 defines it: 

 
Figure 50: The Help Menu 

 
 

Table 13: Help Menu Features 

Menu Command Function 
Check for updates Search the Kramer 

Electronics Web site for 
software updates. 

About Kramer RC 
Configuration 

Shows the current software 
version. 

  
  
  

                                                        
1 Dynamic Host Configuration Protocol: Allows the network administrator to distribute IP addresses from a central point and 

automatically send a new IP address when an Ethernet point is plugged into a different network location 
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6.6 Load Firmware 

To load new firmware: 
1. From the Device menu select Load Firmware. 

The Load Firmware Upgrade window appears: 

 
Figure 51: Load Firmware Upgrade Window (SV-551) 

2. Click the Connect button. 
The Connect Window appears: 

 
Figure 52: Connect Window 
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1. Choose the connection method according to the cable connection you have 
made between the PC and your product. 

3. Click OK. 
4. Select the device for upgrade from the list box1

5. Click the Browse button to find the firmware file. 
. 

 
Figure 53: Load Firmware Upgrade Window (RC-6x) 

6. Connect to the device. 
7. Click the Connect button to connect the device and then click Start Upgrade. 
8. Upon completion, open the Device Properties window (see Figure 49) to make 

sure the firmware was upgraded2

 
. 

 
 
 

                                                        
1 When selecting a room controller device such as RC-6x, you have to select the connection method: Direct connection or 

Connection via SV-551 via K-NET 

2 If the firmware number remains the same, close the Device Properties windows, disconnect and then reconnect the device, 

and open the Device Properties window again to check the firmware number 
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7 Connecting the RC-6X Series Room Controller as a 
Standalone Device 

You can configure the Room Controller to be used as a standalone device. To 
do this you have to connect the Room controller directly to your PC via the 
USB connector. 

To define the RC as a Master device: 
1. From the Device Menu, click Connect…. 
2. Select the connection method to be USB, select the port and click OK. 

The following warning appears: 

 
Figure 54: Transforming to the Standalone Configuration 

3. Click Yes. 
The room controller is now standalone and the Device description appears as 
follows: 

 
Figure 55: Standalone Device Description 

When in the standalone mode, you can write the command sequences directly 
to the room controller by clicking the Write Configuration button in the 
Device area (see section  9).  

The following windows will appear differently when in the standalone mode: 
• The Port Manager window, see section  7.1 
• The Device Properties window, see section  7.2 

 
 
 
 
 
 



KRAMER:  SIMPLE CREATIVE TECHNOLOGY 

Connecting the RC-6X Series Room Controller as a Standalone Device 

 44 

7.1 The Port Manager in the Standalone Mode 

The Port Manager1

Figure 56
 displays the ports relevant to the room controller, as 

illustrated in  (for example, for RC-52): 

 
Figure 56: The Port Manager in the Standalone Mode 

7.2 The Device Properties Window in the Standalone Mode 

Figure 57 shows the Device Properties window in the standalone mode: 

   
Figure 57: The Device Properties Window in the Standalone Mode 

To exit the standalone mode open the Device menu and select Set as Slave. 
 
 
 

                                                        
1 The Main Display column is N/A 
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8 Connecting via the ETHERNET 

You can connect the SV-551 via the Ethernet, using a crossover cable (see 
section  8.1) for direct connection to the PC or a straight through cable (see 
section  8.2) for connection via a network hub or network router. 

8.1 Connecting the ETHERNET Port directly to a PC (Crossover 
Cable) 

You can connect the Ethernet port of the RC device to the Ethernet port on your 
PC, via a crossover cable with RJ-45 connectors.  

This type of connection is recommended for identification of the factory default  
IP Address of the RC device (192.168.1.39) during the initial configuration 

After connecting the Ethernet port, configure your PC as follows: 
1. Right-click the My Network Places icon on your desktop. 
2. Select Properties. 
3. Right-click Local Area Connection Properties. 
4. Select Properties. 

The Local Area Connection Properties window appears. 
5. Select the Internet Protocol (TCP/IP) and click the Properties Button (see 

Figure 58). 

 
Figure 58: Local Area Connection Properties Window 
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6. Select Use the following IP Address, and fill in the details as shown in  
Figure 59. 

7. Click OK. 

 
Figure 59: Internet Protocol (TCP/IP) Properties Window 

8.2 Connecting the ETHERNET Port via a Network Hub (Straight-
Through Cable) 

You can connect the Ethernet port of the RC device to the Ethernet port on a 
network hub or network router, via a straight-through cable with RJ-45 
connectors. 

9 Writing a Configuration 

Once your configuration is ready, you can write it to the device, via the “Write 
Configuration” button. 

Note that if the room controller is defined as a: 
• Master (standalone), the configuration is written directly to the device 
• Auxiliary device (for example, the room controller is connected to the 

SV-551), the configuration is written to the SV-551 

In case you have written the configuration to a standalone device and it is now 
connected as an auxiliary device to the SV-551, you have to write the 
configuration once again after defining the device as an auxiliary device. 

To write a configuration to the device, do the following: 
1. Connect the PC to the:  
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 RC-6x (standalone) to write the configuration directly to the RC-6x 
 SV-551 (in a SummitView™ kit setup) to write the configuration to 

the SV-551 
2. From the File menu, select Load Configuration1

Figure 60
…. 

The Open window appears (see ). 
3. Click Open1 
4. In the Device area in the RC-SV Configuration  main window, click the Write 

Configuration button2

 

. 
The configuration is written to the device. 

 
Figure 60: Loading a Configuration 

 

                                                        
1 Skip this step if you have the desired configuration loaded 

2 The Write Configuration button is enabled only when the device is connected 
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